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Wichtig!!! 

 

 

 

Falls Sie als Fahrleiter oder Sondenoperator  

- eine Schulung benötigen  

- sich einen Extra Sonden Check-up vor der Reise wünschen**  

- technische Unterstützung brauchen 

- extra Sensoren anbringen wollen 

- Sonderwünsche (Probenentnahme, höhere Datenauflösung usw.) haben 

- Fragen oder Probleme haben (komische Profile, Fehlermeldungen, 

fehlerhafte Messwerte usw.) 

 

können Sie sich jeder Zeit bei der ozeanographischen Arbeitsgruppe im SF 

melden: 

 

sf-oceanography@thuenen.de 

 

Telefonisch erreichen Sie uns unter: 

 

Andriy Martynenko:  0471/ 94460 - 241 

Annika Elsheimer:   0471/ 94460 - 242 

Anna Akimova:   0471/ 94460 - 253 

 

 

 

** alle die Sonden wurden von uns regelmäßig (1 Mal in 2-3 Monate) gecheckt  

mailto:sf-oceanography@thuenen.de
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Achtung bei Winterreisen!!! 

 

 
Beachten sie bitte bei Solea-Winterreisen folgendes: 

 

  

 

während Winterreisen (vor allem bei niedrigen oder Frosttemperaturen) soll 

die CTD Sonde zwischen den Stationen in die Windenvorrichtung gebracht 

werden. Dort wurde ein Vorhang angebracht und demnächst werden auch zwei 

Heizkörper hingestellt. Die Sonde muss bei Temperaturen über dem 

Gefrierpunkt gelagert werden! 

 

 

 

Achten Sie bitte auch drauf, dass die Sonde zwischen die Reisen nicht in 

einem ungeheizten Bereich gelagert wird. Andernfalls erhöht sich 

die Gefahr von Frostschäden am Sauerstoffsensor! 

 

 

 

Für Fragen steht die Arbeitsgruppe Ihnen gerne zur Verfügung 

(sf-oceanography@thuenen.de).  

mailto:sf-oceanography@vti.bund.de
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Vor der Reise bzw. vor der ersten Station 

 

Vorbereitung Flaschenkisten: 

 

- Holzkisten an einem vor Wasser geschützten Platz aufstellen, damit 

die Kisten nicht durch Salzwasser feucht werden, Metallteile 

korrodieren und das Holz aufquillt. 

 

- Kisteninhalt auf Verunreinigungen und Absplitterungen prüfen, falls 

vorhanden Flasche bitte nicht verwenden! 

 

Sondenvorbereitung und Sondenreinigung: 

 

- Abdeckhaube entfernen 

- vor der ersten Station die Sensorenzelle mit De-Ionized Wasser füllen. 

Dauer: 1 Stunde (s. Sondenreinigung nach jeder Station, S.23) 

 

Testlauf (Dry test) 

 
ACHTUNG !!!  Wasserschöpfer können beschädigt werden, wenn sie im 

Trockenen ausgelöst werden! Deswegen müssen Wasserschöpfer während 

des Testlaufes ausgespannt sein. 
 

 

- Deckunit einschalten. Die Deckunit der Sonde ist im Regal auf der 

Brücke (Abb. 1, Seite 6) angebracht 

- Kontrollleuchte überprüfen 

 „Serial Data“ leuchtet 

- SeasaveV7 öffnen und Software einstellen (s. Seasave Einstellungen f. 

Testlauf, S.7) 

- Angezeigte Werte überprüfen (s. Sensortestwerte, S. 11) 

- Wasserschöpfer testen (s. Wasserschöpfer Test, S.12) 
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Abb. 1. Deckunit SBE33 auf Solea 
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Seasave Einstellungen f. Testlauf 

 

 

1. Seasave öffnen. Üblicherweise wird der passende .psa-File automatisch 

geladen. Wenn nicht s. „Datenaufnahme mittels Seasave“, Seite 17 

 

2. Mit rechtem Mausklick auf dem jeweiligen Fenster kann man unter 

Modify die benötigten Parameter und Messbereiche auswählen/einstellen. 

 

3. Real-Time-Data → start… drücken. Im Pop-Up Fenster Begin 

archiving data immediatly auswählen (Abb.6, Seite 10). 

 

4. Im gleichen Fenster unter SelectOutputDataFileName Zielort und 

Namen der Datei eingeben.  

Der Dateiname setzt sich aus Schiffskürzel + Reisenummer+“test“, 

zusammen, z.B. SB999test.hex.  

 

5.  Start drücken, Header Information wird geöffnet. Ship, Station, 

Operator eingeben (als Station kann man „test“ benutzen) und auf OK. 

Die Verbindung zur Sonde wird aufgebaut und die Datenaufzeichnung 

beginnt. 

 

 

 

 
Abb. 2.  Default setup für Seasave Deckunit (Seasave_7_23.2.psa) 
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Abb. 3. Konfiguration File auswählen.  

 

 
Abb. 4. NMEA Einstellung im .con File. 
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Abb. 5. Ändern NMEA Einstellungen 
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Abb. 6. Data Acquisition Fenster 
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Sensortestwerte. 

 

Prüfen ob die Sensoren die zu erwartenden Werte anzeigen: 

 

- Depth (Salt water, m) sollte ungefähr „0“ sein 

- Potential Temperature sollte Luft-/Raumtemperatur anzeigen 

- Salinity sollte „0“ zeigen 

 

Falls weitere Parameter ausgewählt wurden: 

- Fluorescence: der Wert sollte sich verändern, wenn man einen 

Gegenstand in den Messstrahl hält 

- Turbidity : der Wert sollte nah zu 0 FTU sein und sich verändern auf 

20-50 FTU, wenn man die Hand dicht unter den Sensor hält 

 

 

Falls die Werte von o. genannte stark abweichen, melden Sie sich bitte 

telefonisch oder bei: 

 

 sf-oceanography@thuenen.de  

 

 

mailto:sf-oceanography@thuenen.de
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Wasserschöpfer testen.  

 

ACHTUNG!!! Wasserschöpfer können beschädigt werden, wenn sie im 

Trockenen ausgelöst werden! Deswegen müssen Wasserschöpfer 

geschlossen sein. 

 

 

1. Prüfen ob die Häkchen leichtgängig sind, aber festsitzen, wenn sie 

eingespannt sind 

2. Die Häkchen alle einspannen 

3. Über das Fenster FireBottleControl Häkchen für Schöpfernummer 1 

auslösen 

 

 
 

4. Man muss ein leises Klicken hören und das Häkchen muss nun frei 

beweglich sein 

5. Dies bei allen Schöpfernummern testen 

6. Mit Real Time Data → Stop… beendet man die Aufzeichnung 

7. Deckunit (Deckunit) ausschalten!! 

 

ACHTUNG!!!! Unbedingt nach jeder Station oder Testlauf Deckunit 

wieder ausschalten, da sonst die Pumpe trocken läuft und dies zu massiven 

Schäden führt.  
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Station benennen: 

 
Schiffskürzel + Reisenummer + Schiffsstationsnummer, 

 

ist am linken Rand des Datadismonitor ablesbar (Abb. 9, Seite 22) 

 

 

Beispiel:   SB280786    

Keine Leerzeichen dazwischen oder Unterstriche einfügen. 

 

Es ist wichtig, dass die Stationsnummer vom Schiff genommen wird, damit man 

die Station später in den Datadisaufzeichnungen wiederfinden kann. 

 

ACHTUNG!!!  Die Stationsnummer und der Filename müssen identisch 

sein!!! 

 

Schiffskürzel:    HC= Walther Herwig III SB=Solea CB=Clupea 

 

 

 

 

 

 

 

Auf Station 
 

Aus Sicherheitsgründen muss folgende Schutzkleidung getragen werden: 

1. Helm 

2. Sicherheitsweste (welche mit der Sicherungsleine am Schott 

verbunden wird) 

3. festes Schuhwerk 
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Messverfahren 

 

Achtung!! Schutzschläuche (z.B. Tygonschlauch, Abb. 14, Seite 255) und 

anderes mögliches Spülzubehör ( z.B. Abb. 12, Seite 244) von der Sonde 

entfernen. 

 

1. Wasserschöpfer spannen (Achtung!! Die Flaschen sollen offen sein, 

auch wenn keine Wasserproben genommen werden. Das 

Runterfahren mit geschlossenen Flaschen beschädigt diese. Man 

kann auch alle Schöpfer abbauen, wenn sie nicht gebraucht werden). 

 

2. Lüftungsschrauben und Hähne schließen (Scheibe muss rausgezogen sein) 

- s. Abb 7, Seite 16 

 

3. Deckunit (Deckunit) einschalten. 

 

4. Seasave aufrufen und den gespeicherten .psa-File öffnen bzw. selbst das 

Display einstellen (s. „Datenaufnahme mittels Seasave“, Seite 17). 

 

5. Real-Time-Data → start… drücken. Im Pop-Up Fenster Begin 

archiving data immediatly auswählen (Abb.6, Seite 10). 

 

6. Unter SelectOutputDataFileName Zielort und Namen der Datei 

eingeben.  

Der Dateiname setzt sich auf Schiffskürzel + Reisenummer + 

Stationsnummer zusammen, z.B. SB999360.hex (s. Station 

benennen). Hierbei ist darauf zu achten, dass die Stationsnummer 

identisch mit der Schiffsstationsnummer ist! 

 

7. Start drücken, Header Information wird geöffnet. Ausfüllen und auf OK.  

Die Verbindung zur Sonde wird aufgebaut und die Datenaufzeichnung 

beginnt. 

 

8. Sonde ins Wasser lassen 

 

9. Sonde mindestens 2 Minuten in 2m bis 10 m Tiefe hängen lassen bis 

Pumpe anspringt und Sonde somit messbereit ist. Die Messung sollte so 

oberflächennah wie möglich beginnen um auch diese Werte erfassen zu 
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können, allerdings ist dies abhängig vom Seegang, die Sonde muss auf 

jeden Fall immer komplett im Wasser sein! 

 

Die Messung ist unbrauchbar wenn die Pumpe nicht läuft!!! 

 

 

10. Stationsprotokoll ausfüllen (s. Stationsprotokoll, Seite19) 

 

11. Temperatur und Salzgehalt müssen konstant sein! Da bei der SBE19+ 

kein Pumpstatus angezeigt werden kann, muss man umso genauer auf die 

beiden Werte achten und wirklich die 2 Minuten abwarten! Ansonsten 

können die Daten nicht verwendet werden! 

 

12. Die Sonde wieder an der Oberfläche bringen, damit man das komplette 

Messprofil von der Oberfläche bis zum Boden bzw. gewünschte Tiefe 

bekommt. 

 

13. Kommando „Fier weg mit 0.5 m/s“.  

 

Achtung!!! Die SBE19+ hat eine niedrigere Messfrequenz als die große 

Sonde auf WHIII, deswegen sollt sie mit 0.5 m/s gefiert werden. 
 

14. Ca. 5m über Grund (Altimeteranzeige) Kommando „Stopp“ 

 

15. Kommando „Hieven“ 

 

16. Falls Wasserproben benötigt werden, wählt man die Tiefe mit dem 

geringsten Salzgehaltsgradienten während des Downcast. Während des 

Upcast wird der Wasserschöpfer in den gewünschten Tiefen gestoppt, 2-3 

Minuten warten und die Schöpfer schließen (über das Fenster 

FireBottleControl in Seasave).  

 

Achtung!!! Die Proben sollen nicht nah am Meeresboden genommen 

werden, sonst verschlechtert sich die Datenqualität wegen der 

Trübung. Nach Möglichkeit sollen die Proben mindestens 50 m über 

den Boden genommen werden, im flachen Gebiet nicht näher als 10 

m zum Boden. Bevor die Schöpfer geschlossen werden, muss man 2-3 

min in gewünschter Tiefe die Sonde anhalten, damit sich die Sensoren 

und das Wasser im Schöpfer thermodynamisch stabilisieren. 
 

17. Wenn die Sonde an Deck ist, die Datenaufzeichnung in Seasave beenden 

(über Real Time Data → Stop)  
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18. DECKUNIT AUSSCHALTEN! 

 

19. Alle 4 Dateien (.hex-File, .con-File, .hdr-File, .bl-File) pro Station noch 

mal in einen Backup Ordner oder USB-Stick kopieren 

 

20. Wasserproben entnehmen (s. Probenentnahme für Salzgehaltsproben, 

Seite 23) 

 

21. Sonde reinigen (s. Sondereinigung nach jeder Station, Seite 23) 

 

22. Vor längeren Stehzeiten der Sonde oder beim Transport ist darauf zu 

achten, dass die Wasserschöpfer NICHT gespannt sind! 

 

23. Sobald die Sonde nicht täglich genutzt wird oder von Schiffsseite 

Arbeiten in der Nähe anstehen, immer die Abdeckhaube darüber 

ziehen! 
 

ACHTUNG!!!! Unbedingt nach jeder Station Deckunit wieder 

ausschalten, da sonst die Pumpe trocken läuft und dies zu massiven 

Schäden führt.  

 

  
Abb. 7. Wasserschöpfer.  

 

 

Lüftungsschraube 

Hahn 
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Datenaufnahme mittels Seasave 

 

SeasaveV7 ist ein Programm von Seabird um Echtzeitdaten (von Sonden) 

aufzunehmen und anzeigen zu lassen. Es können aber auch archivierte Daten 

angezeigt werden. Nachfolgende Beschreibung gilt für Version SeasaveV7.20c: 

 

 

1. Unter File → Open Setup File → 

D:\Ozeanograf_Daten\SBxxx\PSA_Files\ den zur Sonde passenden 

.psa-File öffnen (Abb. 2, Seite 7) oder eigene Setting-Datei erstellen 

(s. Seasave Display Einstellungen, Seite 18) 

 

2. Unter Configure Inputs → Instruments Configuration → Open → 

D:\Ozeanograf_Daten\SBxxx\Con_Files (z.B. 6434\19P-6434-

05012016.xmlcon) immer den .con-File zur entsprechenden Sonde 

auswählen (s. Abb. 3, Seite 8). .con-File hat die 4-stellige 

Gerätenummer, Die Gerätenummer steht auf dem Seabirdlabel des 

Sondengehäuses. 

 

ACHTUNG!! Im .con-File stehen alle Kalibierungswerte für die einzelnen 

Sensoren, die dürfen in diesem File nicht geändert werden! 

 

3. Darauf achten, dass NMEA position data added auf YES steht (Abb.4, 

Seite 9). Falls nötig über Modify die NMEA-Einstellung ändern, 

indem man das Häkchen setzt und NMEA device connected to deck 

unit auswählt (Abb.5, Seite9). 

 

4. Real-Time-Data → start… drücken. Im Pop-Up Fenster Begin 

archiving data immediatly auswählen (Abb.6, Seite 10). 

 

5. Weiter geht’s mit Schritt 6 in ‚Messverfahren‘, Seite 14 
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Seasave Display Einstellungen 

 

Unter Display wählt man folgende Fenster aus: 

 

- Plot Display, zum anzeigen des Profils 

- Fixed Display, zum Anzeigen der aktuellen Messwerte als Standmodus 

 

 

Mit rechtem Mausklick auf dem jeweiligen Fenster kann man unter Modify die 

benötigten Parameter und Messbereiche auswählen/einstellen. 

 

Unter Real Time Control → Fire Bottle Control auswählen, dann öffnet sich 

das Fenster zum Auslösen der Wasserschöpfer 

 

Neue .psa-Datei kann man an beliebigen Ort speichern, aber bitte die 

bestehenden .psa-Files (vorbereitete optimale Einstellungen für unsere Sonde) 

nicht überschreiben! 
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Stationsprotokoll ausfüllen 

 
Abb. 8. CTD-Sonden Protokoll.  

 

Folgende Parameter kann man vom Datadismonitor ablesen (Abb. 9, Seite 220): 

 

 Schiff/Reisenummer 

 Stationsnummer 

 Datum 

 Koordinaten 

 Uhrzeit UTC: Profildauer, „von“ bedeutet Start ist Kommando „Fieren“, 

„bis“ bedeutet, dass Sonde tiefsten Meßpunkt erreicht hat 

 Gelotete Tiefe 

 Windrichtung und –geschwindigkeit 

 Lufttemperatur und –feuchtigkeit 

 Luftdruck 
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Die meteorologischen Daten wie Wetter, Bewölkung, See und Eisverhältnisse 

muss man selber bestimmen, man sitz ja auf Brücke oder steht an der Sonde und 

kann einen Blick nach draußen riskieren um zu sehen ob es zum Beispiel schneit 

oder regnet, wie hoch die Wellen sind, ob es bewölkt ist oder ob Eisberge in der 

Nähe sind. (Wettercode-Tabellen Abb.10, Seite 21)  

Wichtig ist auch, dass man die Flaschennummer zur passenden 

Schöpfernummer einträgt. 

 

 

 

 

 
Abb. 9. Datadis Bildschirm 
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Wettercode Tabelle. 

 
Abb. 10 Wettercode-Tabellen 
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Probenentnahme für Salzgehaltsproben 

 

ACHTUNG!!! Die Probennahme muss sehr sorgfältig und genau wie 

beschrieben durchgeführt werden. Besser keine Probe, als falsch 

genommene Probe. 

 

1. Flasche 3-mal spülen: 

 

- Lüftungsschraube öffnen 

 

- Hahn öffnen (Scheibe reindrücken indem der Stift am Schöpfer 

durch das Loch in der Scheibe geführt wird), Flasche unter den 

freien Wasserstrahl halten (ohne, dass der Schlauch die 

Flaschenöffnung berührt) und etwa zu einem Drittel füllen, Hahn 

schließen, Flasche kurz schütteln und über den Schlauch ausgießen. 

Zweimal wiederholen. 

 

2. Flasche endgültig füllen, dabei max. nur bis 3cm vor unterem Rollrand 

 

 

 
 

3. Gewinde und oberen Abschluss mit einem sauberen trockenen 

Papiertuch sorgfältig abwischen, so dass kein Salzwasser im Gewinde 

und der planen Fläche verbleibt!!! 

 

4. Kunststoffstopfen vollständig bis zum Anschlag in den Flaschenhals 

drücken. Kappe aufschrauben und die Flasche in der richtigen 

Reihenfolge in die Kiste stellen. 

 

5. Kistenummer und Flaschenummer im Protokoll notieren, 

Flaschennummer zur dazugehörigen Schöpfernummer notieren. 

 

Volle Kiste an geschütztem Ort lagern. 

unterer Rollrand 

 

maximale Füllhöhe 
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Sondenreinigung nach jeder Station. 

 

Wer sich bei der Sondenreinigung unsicher ist oder zum ersten Mal mit der 

Sonde arbeitet kann eine Schulung bekommen (nach Vereinbarung). Bei Fragen 

und Probleme sind wir jederzeit (auch während der Reise) unter folgende 

Emailadresse zu erreichen: 

 

sf-oceanography@thuenen.de 

 

 

1. Die komplette Rosette und Sonde mit Süßwasser gründlich abspülen. 

 

2. Die Sensorzelle mit Triton 0.1% spülen (Abb. 12, Seite 244). Dazu 

Spritze einmal mit Triton 0.1% aufziehen. Schlauch über 

Sensoreingang stülpen und Spritze 2 bis 3 Mal leeren und wieder 

ansaugen (d.h. Kolben hochziehen und runterdrücken) 

 

ACHTUNG!!! Die Tritonlösung darf sich nicht länger als eine 

Minute in der Sonde befinden. 

 

3. Die Sensorenzelle 30sec mit Süßwasser durchspülen, dazu 

Süßwasserschlauch direkt auf den Sensoreingang drauf setzten und 

Wasser laufen lassen(Abb. 12, Seite 244 und Abb. 13, Seite 244) oder 

Sensorzelle per süßwassergefüllter Spritze durchspülen (Abb.12, Seite 

24). 

 

4. Tygonschlauch über Sensoreingang und Pumpenausgang stülpen, 

somit ist die Sensorzelle geschützt (Abb. 14, Seite 255). 

 

mailto:sf-oceanography@thuenen.de
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Abb. 12. Sensorzellenreinigung (mit Tritonlösung, Süßwasser oder De-

Ionized Wasser) 

 

 

 
Abb. 13. Sensorzellenreinigung mit Süßwasser 

 

 

 

 

 

Süßwasserschlauch auf 

Sensoreingang 
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Abb. 14. Stellung des Tygonschlauches 

 

Pumpenausgang 

Tygonschlauch 

Sensoreingang 
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Routinereinigung (1-mal pro Woche): 

 

Wer sich bei der Sondenreinigung unsicher ist oder zum ersten Mal mit der 

Sonde arbeitet kann eine Schulung bekommen (nach Vereinbarung). Bei Fragen 

und Probleme sind wir auch jederzeit (auch während der Reise) unter folgende 

Emailadresse zu erreichen: 

 

sf-oceanography@thuenen.de 

 

1. Die komplette Rosette und Sonde mit Süßwasser gründlich abspülen. 

 

2. Die Sensorzelle mit Triton 1% spülen (Abb. 12, Seite 244). Dazu 

Spritze einmal mit Triton 1% aufziehen. Schlauch über Sensoreingang 

stülpen und Spritze 2 bis 3 Mal leeren und wieder ansaugen (d.h. 

Kolben hochziehen und runterdrücken) 

 

ACHTUNG!!! Die Tritonlösung darf sich nicht länger als eine 

Minute in der Sonde befinden. 

 

3. Die Sensorzelle 30sec mit Süßwasser durchspülen, dazu 

Süßwasserschlauch direkt auf den Sensoreingang drauf setzten und 

Wasser laufen lassen(Abb. 12, Seite 24 oder Abb. 13, Seite 244) ) oder 

Sensorzelle per süßwassergefüllter Spritze durchspülen (Abb.12, Seite 

24). 

 

4. Die Sensorzelle mit Bleichmittel 0,05 – 0,1% (Natriumhypochlorit) 

Lösung spülen. Spritze einmal mit Bleichmittel aufziehen. Schlauch 

über Sensoreingang stülpen und Spritze 2 bis 3 Mal leeren und wieder 

ansaugen (d.h. Kolben hochziehen und runterdrücken) 

 

ACHTUNG!!! Das Bleichmittel darf sich nicht länger als eine 

Minute in der Sonde befinden. 

 

5. Die Sensorzelle 30sec mit Süßwasser durchspülen, dazu 

Süßwasserschlauch direkt auf den Sensoreingang drauf setzten und 

Wasser laufen lassen(Abb. .12, Seite 244 oder Abb. 13, Seite 244) ) 

oder Sensorzelle per süßwassergefüllter Spritze durchspülen (Abb.12, 

Seite 24) 

 

6. Tygonschlauch über Sensoreingang und Pumpenausgang stülpen, 

somit ist die Sensorzelle geschützt (Abb. 14, Seite 255) 

mailto:sf-oceanography@thuenen.de
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Ende der Reise 
 

 

Sondenreinigung am Ende der Reise: 

 

1. Routinereinigung durchführen (s. „Routinereinigung“, Seite 26) 

Wenn die Sonde sichtbare Verschmutzung aufweist: 5-mal 

Routinereinigung wiederholen 

2. Gründlich mit De-Ionized  Wasser durchspülen (Abb. 12, Seite 244) 

3. Trocknen lassen 

4. Tygonschlauch über Sensoreingang und Pumpenausgang stülpen, 

somit ist die Sensorzelle geschützt (Abb. 14, Seite 255) 

5. Abdeckhaube über die Sonde ziehen 

 

Achtung!!! Bei Frosttemperaturen ist darauf zu achten, dass die Sensorzelle 

trocken ist um die Sensoren vor Frostschäden zu bewahren. 

 

Nach der Reise die Daten (4 Files pro Station - .hex, .hdr, .con, .bl), Protokolle 

und Flaschenkisten bei der ozeanographischen AG im SF abgeben. 

 

Die Daten können per Mail an sf-oceanography@thuenen.de gesendet werden.  

 

Die Protokolle entweder persönlich abgeben oder per Post an: 

 

Annika Elsheimer oder Andriy Martynenko 

 

TI-SF 

Herwigstraße 31 

27572 Bremerhaven 

 

Die Flaschenkisten müssen bei Annika Elsheimer oder Andriy Martynenko 

abgegeben werden. 

mailto:sf-oceanography@thuenen.de

